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A Letter to the desk of the Editor 
The Christmas is approaching nearby and all the people are in festive mood. Keeping this in mind, we have published a 
specially designed Christmas issue for our readers. 

In this issue, there will be an exclusive as well as informative cover story written by Claudio Cosentino, the renowned production 
designer and teacher from Italy. In this cover story, Mr. Cosentino focuses on the impact of latest 3d printing technology 
together with industrial, medical, building and space for creating a digital model through a 3d modeling software like sketchup. 

In article section there exists five exclusive articles. Out of five articles, four articles are written by the editorial team of the 
magazine and one article is written by Fred Abler, Ceo of Form Fonts. 

The first article is about some useful tricks and tips on various sketchup tools which can increase the speed of 3d modelers to a 
great extent. 

The second article features Form Fonts, go-to subscription based collection of 3d models and textures which can be used with 
sketchup and various photo-real rendering programs. 

The third article highlights how architectural design is evolved through digital sketching pattern with the use of some useful 
digital sketching tools like sketchup. 

The fourth article is written by our editorial team which explains the importance of 3D mouse to the sketchup and 3d designers 
as well as its various applications. 

The last and final article is about how sketchupfab and Fule3D have tied a knot for uploading 3d models in web. 

In tutorial section, the most promising 3D artist Salah Hussein who associated with Dragon FX Studio, has presented an 
exclusive tutorial on Mystique FX with 3ds Max. This FX is Procedural and it can be applied to any mesh as per your choice. 

In another tutorial, Warunyoo Songkran, the experienced environmental engineer, shows how sketchup dynamic components 
greatly facilitate the construction design process. 

In interview section, the team of sketchup ur space has interviewed Artur Coelho, an ICT/arts teacher as well as sysadmin, 
researcher, amateur artist and science fiction fan from Portugal. With this interview, Mr Arthur briefly explains how sketchup can 
be integrated into the ICT curriculum. 

In blog section the readers will get lots of sketchup tips and in news section there will be several current updates on sketchup 
world. 

Hope this issue will contain the items of great interests to our readers. 

 

Best wishes  
Rajib Dey 
Editor-in-chief 
For any feedback and query please mail us at rajib@sketchup-ur-space.com  

 

 

 

 

mailto:rajib@sketchup-ur-space.com�
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Interview with Artur Coelho - an ICT/arts teacher as well as sysadmin, 
researcher, amateur artist and science fiction fan from Portugal 

Interviewer : Rajib Dey (Editor-in-chief) 

Please introduce yourself to our readers. 

I'm an elementary school teacher in the Portuguese educational system. I teach introduction to communication technologies (ICT 
for short) to pupils in the 12 to 14 year old age range. Taking care of the school's computer systems is inherent to my job. I came 
into ICT via the arts, beginning my teaching career as an arts teacher, and I love to do visual experiments with a range of digital 
technologies from 3D to databending techniques. When I took my master's degree in educational science I was determined not to 
do a traditional fieldwork. I concentrated instead in the intersection between creativity, art class and digital technologies, using 3D 
to empower my students ideas. I was very lucky to have a perceptive thesis advisor, who showed me a lot of 3D technologies that 
I wasn't aware of, such as VRML. Incidently, he was the one that challenged me to take up Sketchup for a spin to see if it was 
useful. My thesis is long finished, but I haven't stopped working with 3D in class and sharing my experiences within academic 
settings, generally in educational science conferences. I was very honored this year to be a part of Lisbon Mini Maker Faire, 
portugal's first maker faire, showing my pupil's 3D work to more than 10.000 visitors. 

 
teaching sketchup to ICT teachers (a first here, i believe) (i'm the guy in the red t-shirt) 

You have huge experiences teaching in 3D. How do you integrate sketchup with your profession? 

First and foremost I had to find a way to integrate the tool into the ICT curriculum. Sometimes we use 3D freely with students in 
interdisciplinary projects, but most of my teaching is done in a specific class. After a couple of trials and experiments I've 
assembled a learning path for the pupils that allows me to use creative technologies, giving my students the opportunity to 
explorer several programs and techniques, respect curricular goals and guidelines. My programmatic approach uses two 
semesters. In the first the focus is in 3D modeling and animation, the second focuses on image and video editing and introduction 
to programming. That's where Sketchup comes in. The 3d aspect uses three main apps: Doga L3, an old but fun japanese 
program that teaches basic modeling concepts and delights my students with creating robots and fun vehicles, Bryce for 
rendering and simple animation, and, of course, Sketchup. Sketchup's simple interface makes it easy for young children to use, 
and I can teach them to go from the basics to more elaborate and professional work. Since my pupils are very young and part of a 
generalist, elementary curricula the goal is not to make them experts in these technologies, but showing them that they exist (yes, 
they are that young), and how to work with them, using them in project-based learning. Essentially, I use my classroom to give 
them an early start. And sometimes I get real lucky and spark some very promising, talented pupils. This is one of many 
approaches to teaching ICT. The program is open-ended. There are specific goals to achieve but the teacher is free to choose 
learning paths. That means that there are a lot of experiences we can give our students. Some still maintain an office-style 
curriculum, focused on word processing and presentations, but a lot of my colleagues are actively working with programming, 
multimedia, robotics and arduino. Our goal is to empower our students, showing them that they can use technology for much 
more than social networking and pop culture consuming. 
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When and how did you discover sketchup and start to use it in your professional life? 

My first forays into Sketchup were a bit disapointing. Used to other simple, non-professional modeling apps, my first adventures 
were, shall we say, better to be forgotten. But, as I've said earlier, I had (and still do) a very prescient thesis advisor who 
suggested to learn a bit more and try to see if I could take it into my classroom. After getting used to it, I was amazed by how easy 
it was to create with Sketchup, how open-ended and flexible it is. I've become addicted, using it to teach 3D but also in my 
personal projects. But, essentially, I'm a teacher and my focus, Sketchup wise, is in using it as a tool to spark my pupils creativity 
and giving them a glimpse of professional work. I repeat this concept a lot, I know, but I do believe it's essential for teachers to be 
able to spark student's creativity and other abilities with digital tools if we wish elementary education to continue to be relevant in 
a pervasive techonological environment. 

 
introduction to coding and a fun classroom environment. 

How do you evaluate sketchup as a most useful teaching tool? 

Not as most useful. As extremely useful! It's easy to use and intuitive, which means that the learning curve from basic introduction 
to mode advanced use is very fast. Young children do not get dispirited and abandon the tool for being too difficult for them. In 
education terms, it's also a great way to integrate knowledge. Maths, geometry and Visual Arts concepts are woven into the 3D 
modeling process and I go to great lengths to point out to the students that the abstract mathematical concepts that they usually 
find boring and difficult are actually what makes working in 3D so fun. Also, ideas such as light, coloring, textures and so on, with 
at best they are used to think about in bi-dimensional ways in art class, are an integral part of the process of creating a model. 
Remember, I'm not a professional 3D teacher and my pupils are part of the elementary schooling system, so here the idea is 
showing them that the compartimentalized knowledge they acquire in different classrooms can, and is, integrated and useful in 
other settings. 

Then, of course, there's also the loftier goal of sparking their abilities. In this way Sketchup is also invaluable. It's, as we all know, 
a very capable and rigorous tool. With it students abilities can be nurtured in a more professional environment. That is very 
important for those of them that may, in the future, choose professions that are heavily dependent on 3D. It's one thing to show all 
of them that 3D is fun with simple programs that make it easy to create, but a necessary next step is teaching them a bit about 
professional workflow, project making and rigorous modeling. This, of course, is not for all, only for those that show more promise 
in 3D. The basic premiss of this approach is giving students a glimpse of a wide range of technologies that they may use in 
empowering ways. I find a lot of promising 3d modelers, but also a lot of very creative programmers or video editors. And, of 
course, the main goal is not to teach specialized knowledge, but to make them adept at problem solving with digital tools. 

Ah, this may seem a bit shocking for readers of this magazine. I know there are a lot of books on Sketchup, a lot of them very 
good, but for me the best was Aidan Chopra's Sketchup for Dummies. Yes, I've just wrote that. Yes, I've chosen a

Can you recommend any good book on sketchup? (Written by yourself or others)? 

 for 
dummies book as a great resource. And, for me, it was. I'm self-taught on Sketchup. I've had no teacher to show me the ropes 
and training me with a sequential learning approach. I had to rely on the global community. Lots of great YouTube videos out 
there, by the way. Chopra's book enabled me to sequentialize knowledge about Sketchup's tools and workflow, and from there 
establishing a learning path that makes it easy for my students to learn it. 
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Honestly I can't answer this question easily. One of the reasons for being self-taught is that I was unable to find a training venue 
for Sketchup in Portugal. There are a lot of CAD and 3DS courses, Blender, even. Mysteriously, very little on Sketchup. Then 
again it is part of the secondary and university curricula, so I suppose over here the need for basic training in this tool is minimal. 
Lately I've become aware of Universidade Nova de Lisboa CITI free courses (free as in not belonging to a specific course, alas) 
on 3D with Blender (

There are lots of institutions which provide training on sketchup & other 3d modeling software’s. Can you suggest some 
institutes where people can undergo training at minimum cost? 

http://www.citi.pt/cursoslivres/3d/) and Odd School, which offers masterclasses and specific courses on a 
wide range of 3D and digital imaging practices. Not cheap, but a very good investment for aspiring professionals (http://www.odd-
school.com/pt). For portuguese teachers Anpri (the informatics and ICT teachers association) is organizing Sketchup and general 
3D courses and workshops as part of teacher's professional development (http://www.anpri.pt/). 

ICT in 3D (

What is your most successful project where you implement sketchup? 

http://3dalpha.blogspot.pt/), which is the formal name I gave to the umbrella project that encompasses classroom 
activities and interdisciplinary projects using 3D modeling and animation. Sketchup is wildly popular with my students and 
activities using it (free modeling, architectural patrimony recreation, project-base work) became a very important area of this 
project. ICT in 3D is, essentially, using 3D and multimedia technologies in ICT class... and beyond. We're now looking into 3D 
printing in educational settings, which will give a whole new dimension (pun intended) to Sketchup in class. 

 
teamwork and fun ways to learn 3D 

 

Why 3d visualization is important in architectural and construction design projects? 

Not being an architect or engineer I cannot give a good answer to the second part of your question. But academic ideas kick in 
and my answer is: 3D visualization is important because of visuo-spatial perception. Loosely, without getting into too much detail, 
visuo-spatial perception is about how we create accurate abstract spatial representations, how we conceptualize and think in 3D 
in our brains. Among other things, it allows us to mentally visualize tri-dimensional abstract models of what we want to create. 
Coming from art education as I do, it's a bit shocking to see how most, if not all, of art projects and activities are based on the 
plane and bi-dimensional visualization. This means we could do more to enhace visuo-spatial perception in our students. Of 
course, we do live in a 3D world, and children do interact with a lot of 3D content, but there is little work done bridging natural or 
playful interaction and specific abilities with professional value. This is where 3d tools become important. My very first lessons 
with students center specifically on this: how to mentally visualize shapes and bridge the gap to the bi-dimensional 
representations on screen, showing them that they can't rely on a single point of view and have to work with several perspectives 
and planes of representation. To put it more simply, we live in a 3D world, but in school our students are not used to think in 3D. 
Visualization, whether with Sketchup, gaming environments such as Minecraft, or other tools is doubly important: enhaces 
cognitive abilites in visuospatial perception, and allows those that may follow careers in areas that are very dependent on tri-
dimensional visualization to learn how to mix paper and screen visualizations with mental abstract representation. 

http://www.citi.pt/cursoslivres/3d/�
http://www.odd-school.com/pt�
http://www.odd-school.com/pt�
http://www.anpri.pt/�
http://3dalpha.blogspot.pt/�
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The latest version of Sketchup is Sketchup 2015. Please provide your feedback on this latest version of sketchup. 

I haven't upgraded Sketchup at my school yet. I generally do it in the summer, when there's a lot of free time to do maintenance 
and upgrade my image discs to replicate throughout the school network. I've started to use it on my personal computer and it 
seems to me that it maintains the ease of use and powerful workflow that characterizes Sketchup. And I do have a curious 
anedocte: teaching 3D to ICT teachers in a workshop, one of them asked me if he could draw slanted surfaces (as in poligons not 
drawn on horizontal or vertical planes). I began to answer him no, but then I noticed the new rotated rectangle tool on Sketchup 
2014... 

What suggestions do you want to provide to the professionals who are engaged in teaching with sketchup? 

Share. I've learned a lot with videos and tutorials shared by sketchup users. My very simple, elementary introduction materials are 
also online. Whether you teach in a professional development environment or on a more general educational setting, sharing 
enables the community to learn and develop more their skills. Sharing tips, tricks and approaches enables all of us to create more 
and have more fun with Sketchup. 

 
gifted students love to expand their imagination in sketchup 

 

 

 

 

 

 

 

Please provide your feedback on our magazine? 

Added it to my rss feeds! It keeps me up to date on a lot of sketchup and general 3D news that normally I would not have access 
to in the other channels I follow. It has a very interesting mix of sharing user and creator experiences, general news and tool 
analysis, which is great to keep on the radar for future reference and getting heads up on new ideas. 
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Digital modeling programs & new open source tools are streamlining 3d 
printing process 

Claudio Cosentino 

Hello I am Claudio Cosentino, I am a production designer, a professor of Scenography at the Academy of Fine Arts of 
Catanzaro. 

 
scenography created by art director

In an age where it is increasingly necessary to use digital modeling programs, and new open source tools are developed 
ever faster, the 3D modeling also invades other sectors in addition to those of the graphics, such as industrial, medical, 
building and space, through the use of 3D printers. Natural evolution of printing in two dimensions, 3D printing allows 
you to have a real reproduction of a digital model, created with a 3D modeling software. 

 Marco Trentini for the film "The Decameron" directorDavid Leland 2005 
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model 3d whit Sketchup 8. by Paolo Daniele. student of 3rd year of Production Design. Academy of Fine Arts of Catanzaro, Italy. 

we started a few years ago, the courses in 3d with the use of sketchup. so in addition to modeling, rendering and animation, we 
became interested in 3D printing, producing a plugin stl files, compatible with a 3D printer trade. This process for the preparation 
of files, we realized that: the way we design our models in sketchup had to follow the strict rules imposed by 3d printing. do not let 
double lines, no double intersected faces that are not continuous and connected between them. and a great cleaning of the 
models, very often all this attention is not enough, how do we know where we have made a mistake? Fortunately for us, helps us 
a very interesting plugin, which saves us a lot of time to research the error. but the most important thing is to acquire a new 
design method with sketchup, with models that do not have to submit internal faces hidden, or lines in excess beyond that 
necessary, and all models must have filled the voids and coincident, in the end you have to consider that the molded object must 
be closed, like a box, that is, must have a minimum thickness, that the printer interprets as a part to be printed to give a real 
thickness. 

To get our solid printable, consider a design method different from the traditional modeling, through these simple steps: 

• Make sure that the 3D model that has no point or line unrelated to his geometry. 
• Combine and intersect any faces or lines for the purpose of cleaning the model. 
• The correct model for any errors will be recognized as solid from SketchUp plugin and software slicing needed for 3D 

printing. 
• Check that the model is internally empty, uniform and closed, their faces clear turned outward. 
• Install within Sketchup plugins needed for export .stl format recognizable by other printing software. 

Here are some examples for the creation of a solid: 

A plugin that helps a lot to detect problems inside and outside of the solid is "Solid Inspector." by ThomThom 

You can download the plugin at this link. http://extensions.sketchup.com/it/content/solid-inspector 

 

http://extensions.sketchup.com/it/content/solid-inspector�
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in case of errors you will notice a red circle on the element to be corrected. 

After checking that all the faces are closed and there are no errors proceed exporting the model in STL format 

 
(SketchUp STL) 
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If you have been working properly, the model will be suitable to be printed in any program slicing and 3D printing, then opening it 
in other programs there will be no negative checkmarks or errors. 

 

The end result is considerable comparing it with the digital model 

 

3d printing made by the student Vitaliano Gallo 3nd year of the school of scenography Academy of Fine Arts of Catanzaro. 
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for printing the models must consider that the plate of our 3d printer may contain a model of 20 centimeters x 20 centimeters. 
then in the planning stage with sketchup must make the pieces that do not exceed these measures, then you can pasting or 
predispose before with the slots suitable for assembly. 

for printing of the models must consider that the plate of our 3d printer may contain a model of 20 centimeters x 20 centimeters. 
then in the planning stage with sketchup must make the pieces that do not exceed these measures, then you can pasting or 
predispose before with the slots suitable for assembly. 
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example print medium resolution 3d printing times are acceptable 

 

all these pieces will be printed individually and then hand assembled. 
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model 3d whit Sketchup 8. by Paolo Daniele. student of 3rd year of Production Design. Academy of Fine Arts of Catanzaro, Italy. 
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 example Print Low Resolution 3d printing times are much faster. 
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if you do not need many details on your model you can use a print with a detail very low, with a significant printing speed, useful 
for example for testing. 
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SketchUp - some tips and tactics 
Debamoy Ghosh 

SketchUp is known for its speed activities. It is a quick 3D modeling programme. It often uses as landscaping architects. 
SketchUp is not so tough to learn, but it takes some time to become expert in this trade. Kevin Pfeiffer, writer of landarchs.com 
has come up with this article. We made an excerpt. 

Yes, there are some shortcuts to save the time; still it will take some time to learn. We are trying to present some tricks for your 
help:- 

How to lock axis

 
Image Courtesy: landarchs.com 

: Functioning shape on 3D space on a 2D screen is not simple. There is much confusion taken place 
automatically. If you shift to a circle, you may feel that it would go up along y-axis, witnessed that goes along z-axis. In that case 
you have to use arrow keys for locking the axis. The up and down arrows are Y-axis (Blue) and in the left, the Z-axis (green), then 
turn right x-axis (red). The movement will be known from here. 

Use of array tool: Many people simply copy and paste the sketchup shape objects and other things. Many people also 
repeatedly try Ctrl+v to paste it. It is suggested to use AutoCAD array tool for speedy use of sketchup. 

Watch this video learning: 

https://www.youtube.com/watch?v=7agSNyk8JQA 

Photoshop for vegetation must: Sketchup has many downloadable options (3D Warehouse), but while growing vegetation, the 
file size creates a problem. The best rout is to use Photoshop with PNG format. 

 
Image Courtesy: landarchs.com 

For Large Tool set: see this flow chart 

view> toolbars...> large tool set. 

https://www.youtube.com/watch?v=7agSNyk8JQA�
https://3dwarehouse.sketchup.com/�
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Image Courtesy: landarchs.com 

Hotkeys: If the designers wish to speed up the project, then they can use hotkeys. Follow this: window>preferences>shortcuts to 
obtain the page. SketchUp has developed a list of shortcuts and hotkeys. 

 
Image Courtesy: landarchs.com 

Plugins: These are made for enhancing the capacity of SketchUp. Click the links 

• https://extensions.sketchup.com/en/content/soap-skin-bubble 
• https://extensions.sketchup.com/en/content/sketchup-stl 
• https://extensions.sketchup.com/en/content/3d-tree-maker 
• http://www.suplugins.com/supodium-v2.php 

Side count for polygon: 

https://www.youtube.com/watch?v=h9R2N0nNb7I 

This video tutorial can guide the designers. 

Selecting by click: The Selection on the screen is a major problem in Sketchup. Count the number of click and then, select the 
face and the face and edge and the whole of the object. 

https://extensions.sketchup.com/en/content/soap-skin-bubble�
https://extensions.sketchup.com/en/content/sketchup-stl�
https://extensions.sketchup.com/en/content/3d-tree-maker�
http://www.suplugins.com/supodium-v2.php�
https://www.youtube.com/watch?v=h9R2N0nNb7I�
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Image Courtesy: landarchs.com 

Measurement tool

 
Image Courtesy: landarchs.com 

There is also a ruler tool which marks line on XYZ. 

: The designers need to syn into the measurement, angle and rest of the data into sketchup. This is the 
similarity between sketchup and autoCAD that designers do not need to select the textbox contributing data. 

 
Image Courtesy: landarchs.com 
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Interview with Fred Abler, Ceo of Form Fonts, a go-to subscription based 
collection of 3d models and textures 

Fred Abler 

Form Fonts is our go-to subscription based collection of 3d models and textures. I have been a member of Form Fonts for the last 
9 years and I absolutely cannot exist without this service as a professional designer and visualization artist. The amount of time I 
save and the value added to my 3d presentations is unmeasurable. 

One of my favorite features of Form Fonts is that you can search generic terms like “cars” or “coffee table”, and also brand 
specific terms such as “Audi” or “Design Within Reach”. The collections are enormous and the quality of the models is 
unmatched. Form Fonts models and textures look excellent in SketchUp and photo-real rendering programs. 

Recently we had a chance to chat with Fred Abler, CEO of Form Fonts, to better understand how this resource came to be. Visit 
Form Fonts here to browse the collections and sign up. 

FormFonts 3D : A Decade of Serving Up 3D Models! 

Editors Note: As FormFonts 3D is turning 10, we thought it might be interesting to review the history of the pioneer of 3D Model 
Stock for SketchUp. This is an interview with Fred Abler, CEO of FormFonts.com. 

SketchUp Magazine: How and when did FormFonts get started? 

Abler

 

Of course we all had BIM-like dreams. But where to start? At the time, huge 3D CAD libraries came on-disc with shrink-wrapped 
software, or were sold separately. These ‘block libraries” were pretty basic, outdated the minute you installed them, and they took 
up significant amounts of disc space. 

: In 2001, I was working at the CAD Research Center at Cal Poly, San Luis Obispo, CA where I had done my architecture 
degrees. We developed some pretty cool agent-based spatial decision support systems. But over time, the lab basically became 
a military defense contractor. I wanted to get back to into architecture, and I was especially keen on the potential for ‘smart 
objects’ in architecture. 

A friend at ESRI introduced me to SketchUp, and I was immediately taken by this little 3D modeler. It was just a joy to use. It was 
only for visualization of course, but that’s where the marketplace was in 2001. At the time I was also on a campus committee for 
Internet2 Research - a consortium of 260 universities worldwide connected by a super-fast fiber-optic research network. 

Because Internet2 promised unlimited bandwidth, I began to wonder what impact capacious bandwidth would have on 3D 
modeling. It occurred to me that the effects would be significant. 
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Sketchup was really the first “downloadable” 3D modeler. So I thought: Wouldn’t it be great if you didn’t have to download all 
those stock models? You should just be able to go out to the web, search for what you want, and then download just what you 
need. And because everyone would be able to download the very latest version of a SketchUp component, it would actually be 
practical to update the 3D model library on an ongoing basis. 

SketchUp Magazine : What today we would call “the Cloud” and/or “Software As A Service”. 

Fred Abler: Yes, exactly. But in early 2000’s we didn’t have the cloud yet. It was called a “Service Oriented Architecture”. 

SketchUp Magazine: So how did you test your idea for a 3D Content Cloud? 

Abler: I approached @Last Software in Boulder, Co. and very enthusiastically pitched them on my idea for a ‘living library of 3D 
SketchUp components”. I hired a Computer Science student (Paul Thormahlen) at Cal Poly to write the software for a 3d model 
server and called it “Objective Networks”. I paid for everything out of my own pocket, and designed ObjectiveNetworks.com so 
users could upload their own models, and share them with the SketchUp community. 

SketchUp Magazine: Did you charge for this, or was it free? 

Abler: It was all completely free. At that time it was still unthinkable to charge for anything on the Internet. 

 

SketchUp Magazine: Why do you think ObjectiveNetworks ultimately worked? 

There was nothing else like it at the time. TurboSquid was the only player and they charged pretty dearly for their high-poly 
models. So being first helped a lot. But I also decided that we should show the number of downloads for each contributor’s model, 
kind of as a way to thank them for sharing their model in the first place. 

We had some amazing modelers who were very generous like Markus Sillander, Anri JoJo, and Alan Fraser, etc. Word got out 
pretty quickly you could score free 3D models on Objective Networks, and the SketchUp community was still very small (by 
today’s standards). So fans would upload their sketchup components to Objective Networks, and the model counts would rise 
almost instantly. In fact, a little too quickly. 

Fig 2. Objective Networks screen shot (c. 2003 ) showing free 3D SketchUp Components. Objective Networks was the 
forerunner to the Sketchup 3D Warehouse, and FormFonts 3D. 

This made me take a closer look at the Downloads count, and I discovered something pretty interesting. As soon as an artist 
uploaded their model to share, they would do something very strange. They would instantly turn-around and download it 
themselves 10 or 15 times. 
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Apparently, artists didn’t want anyone to think their model was “un-loved” or “no-good” so they primed the pump! This was fine 
with me if the artists wanted to provide a little of their own social proof. In the three years ObjectiveNetworks was online, we 
served out almost 5,000,000 free 3D components to the nascent SketchUp Community. 

SketchUp Magazine: And didn’t @Last Software give you some grant money at some point? 

Abler: Yes,I demonstrated a private beta version of Objective Networks to Brad Schell at an ESRI conference in 2002. And when 
I showed them how you could drag ‘n drop a 3D model from ObjectiveNetworks.com directly into the SketchUp workspace, they 
almost fell on the floor laughing with delight. 

After that. I asked @Last for some grant money and they graciously gave me $5,000. I took the grant money to the Dean of 
Research at Cal Poly SLO, and she matched it with in-kind equipment and bandwidth, and, that’s how we got our first server. 

SketchUp Magazine: So then, How did ObjectiveNetworks become FormFonts.com? 

Abler: As ObjectiveNetworks got larger and larger, the limits of crowdsourcing became painfully obvious. We tried several ways 
to get the crowd to help us quality-control the models. But all of these efforts were unsuccessful. 

After awhile, the brilliant modelers that were contributing to ObjectiveNetworks started to get a bit resentful. They didn’t like the 
fact that their work was surrounded by junky models people had scrounged up somewhere. And the imbalance between “givers 
and takers” became too hard to ignore. So many more people were downloading models than uploading them, that it started to 
feel truly unfair to those that were contributing. 

As it got worse and worse, the model quality just became almost random. And in many ways, ObjectiveNetworks became a victim 
of it’s own success. The more people that used it, the worse it got. It’s the same complaint a lot of people still have with free sites 
today. 

So the choice was to shutter the site, or turn “pro” and use the lessons learned from the free site as a kind of test marketing. I 
eventually chose the latter, and then began contacting a few of the most talented 3D modelers in the world at the time (Alan 
Fraser, Allister Godfrey, Nino Alvarez, etc.). 

Most of these guys were already selling small collections of their own models on CD, and Alister had even started a small 
website. But the community reaction to actually charging for 3D content had been pretty hostile, so everyone pretty much said 
they would gladly throw in their lot with me, should I started a commercial version of Objective Networks 

SketchUp Magazine: So you started FormFonts.com in 2004? 

Abler

 

: Yes, while ObjectiveNetworks was still serving out free 3D models, I hired Cal Poly students to develop a ‘subscription’ 
version of ObjectiveNetworks. I also asked my architecture classmate Marc Frederickson, to invest and partner with me in starting 
FormFonts. 

Marc provided most of the initial capital we needed to set up commercial grade servers, software development, hosting, 
accounting etc. Today Marc is what I call our Chief Operations Officer. But Marc doesn’t really like titles, so let’s just say he wears 
many hats. 

When FormFonts became the first website to sell 3D content by subscription, most everyone thought (and a few said openly) that 
we would fail. In 2004 paid content was pretty much an unknown, and selling content on CDs was the established norm. 

But in retrospect, we really didn’t have a choice in the matter. The subscription model was the only thing we could do. We couldn’t 
charge much money without a serious backlash, and we just didn’t have that many 3D models to begin with. 
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Fig 3. Splash page of FormFonts.com today. 

We couldn’t leverage the thousands of Objective Networks 3D models because the quality was so variable. And we only had 
about 120 professionally made models when we launched FormFonts 3D, so we couldn’t charge much. I decided to ask $33 and 
make the subscription period just 3 months, and automatically renewing. 

Fortunately, we got the price right and our best was spot on. There was simply no other place you could get professionally made 
SketchUp components at the time. So once people tried and liked our professional 3d models, they decided to stay with us. 

SketchUp Magazine: So ten years on, how many 3D models do you have, and what does your subscriber base look like 
today? 

Abler: FormFonts has more than 50,000 3D models and assets under management. Our annual subscription has been $199 for 5 
years now. We’ll probably need to raise our subscription rates a bit next year, provided the economy keeps improving. 

SketchUp Magazine: And who are your customers? 

About 70% of our subscribers are architects, landscape architects, contractors and other AEC design professionals. 20% are in 
the entertainment industry (film and tv production designers) and 10% are various design professionals (e.g. trade-show booth 
and event designers). 

We also of course support many more file formats now, so our 3D model library is available to a much larger universe of 3D 
modelers, not just SketchUp users. 

SketchUp Magazine : So what will the next 10 years look like for FormFonts? 

Abler: The subscription model has been very very good to us, and FormFonts will keep improving our service in some new and 
interesting ways. We also have been asked to expand the types of 3D models we make, and we’re currently moving into 3D geo-
content and mapping. 

Editors Note: Please check in how FormFonts 3D is doing today, and visit their website : www.formfonts.com 

  

http://www.formfonts.com/�
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How SketchUp Originated and Activated 
Debamoy Ghosh 

Many people ask what is sketch. Some artists believe in manual sketch and some have traditionally gone for digital. They 
generally use sketchup. 

But there is a question that why it is sketchup? There could be many more, or why we use digital sketching pattern. 

There is also the technique of manual sketching. Some people say it is now impractical, tough to learn. 

The growing question is in the creative world that manual sketching now obsolete? What is the fundamental idea of the digital tool 
in the architectural design? 

The three stage of architectural design: 

• Schematic 
• Development 
• Documentation 

There can be physical and mock-up model. The digital revolution, the primary design using pen or pencil, paper drawing, concept 
building into 2D and 3D can be presented. 

Architects start to build up designs and make construction documents, but the schematic design procedure was not really 
computerized. 

The changing scenario: 1960 

The computer-aided design (CAD) started to originate a new direction to research, speedily applied to architectural business. 

The changing scenario: 1970 

It became a commercial product for sale. 

 
Image Courtesy: teslaoutsourcingservices.com 

The computer-aided designs – architectural and engineering were started to come. The old generations of CAD programs stays 
mostly drafting tools on personal computers. 

The changing scenario: 1980 

This is the age of personal computer. This is also the year where Autodesk started to work. 
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These things are prepared by the engineer, but they were typically not designers. They need architectural draft and design. 

The changing scenario: 1999 

The search was on for an alternative programme which is for architect. They also need CAD. But an an alternative programme 
was much of the requirement. Later @last Software was born and various sketching programme were developed. 

The changing scenario: 2000 

SketchUp was born in August 2000. Now it can be said that SketchUp is easy-running software. A 2D drawing can be alternate 
into 3D drawing. But more importantly, it can be done sharply. This is an award winning programme. 

 
Image Courtesy: cabecitasrapadas.org 

The programme has a tri-parted design process -- schematic sketch design, mass study, presentation for alternative design. It 
can be implemented in easy process – interior design, rendering and construction sketch. But it cannot cope with complex sketch 
and realistic rendering. 

  

The changing scenario: 2006 

Google bought it in 2006. Then it was known as Google SketchUp. SketchUp is based on AutoCAD – function, icons, form-
creating, manipulation and rendering command. 

Skill, experience, easy to use, simplicity, interface, accessibility are they main factor. 



  
 

27 | P a g e  
 

How SketchUp designers should handle 3D mouse 
Debamoy Ghosh 

The 3D mouse(s) are best known devices for the users of the SketchUp and 3D designers. It is really an awesome product. The 
3D mouse can work in a speedy way. It is like working is fun here with 3D mouse(s). 

This is the 3D mouse using guidelines that could be followed —and provide videos that dive deeper into each concept. 

First of all, to set up a 3D mouse(s): 

• You need to bring this 3D mouse outside the box. But process of setting up is not so easy. There are many benefit of 
using the 3D Mouse in your system. This amazing video has been powered by 3Dconnexion. Karen Harris has described 
the nutshell of the video that it works. It is very fast and smooth. 

• https://www.youtube.com/watch?v=fe7_ooiA170&list=PL502EC97AD4F7BA13 
• The users can download the device from 3Dconnexion website. 
• Then the installer has to run. 
• Now plug in the USB cable and USB dongle. 
• Use the 3D mouse with non-dominant hand. 
• The users have to grip the 3D mouse cap gently between your thumb and index finger. 
• Softly push, pull, twist or tilt. 
• Practice is the best option. 

Customization of 3D Mouse(s): 

It can be made to use in SketchUp too, as it has the programmable button. It has two programmable buttons. The users can 
assign favourite application and keyboard shortcuts. 

 https://www.youtube.com/watch?v=p22idrpqNRg&list=PL502EC97AD4F7BA13 

  

Image Courtesy: community.openrov.com 

What is the right 3D mouse(s)? 

3D mice permit SketchUp users to work quicker by allowing the place to 3D content using mouse to select. 

Ref: www.3dconnexion.com 

  

https://www.youtube.com/watch?v=fe7_ooiA170&list=PL502EC97AD4F7BA13�
https://www.youtube.com/watch?v=p22idrpqNRg&list=PL502EC97AD4F7BA13�
http://www.3dconnexion.com/�
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Sketchfab and Fule3D make joint venture for publishing 3D Model in Web 
Debamoy Ghosh 

Now if you are an expert designer, you can upload your 3D model to websites. 

How? If you ask, the answer is, the brand new Sketchfab and Fuel3D is bringing this opportunity to the budding modellers all the 
way. 

The Fuel3D has prepared a 3D scanner – which itself can be activated holding in hand. It also has some important features, 
likewise: gives a variation of high-resolution colour, shape and capture different 3D modeling apps. 

There are some game developing apps are there. The 3D scanner can produce exact model of human body. 

Fuel3D can merge pre-calibrated stereo camera with photometric picture for capturing 3D model within seconds. This firm is 
dedicated to make sophisticated 3D scanner and 3D system. 

This scanner was primarily prepared for the health image taking purpose. But later it was taken to the market. 

Ron Daniel, a professor of Engineering Science, Oxford University made this technology. Fuel3D has many technocrats, 
scientists and engineers as their employees. 

Stuart Mead, the CEO was a great fun raiser. He raised around $300,000 by campaign. Later windfall happened their in this 
company. Private investments were on the way to here. The distribution and retail partners’ were signed in across the globe. 

There is an option ‘publish to sketchfab’ in the Fuel3D scanner – used for editing and viewing doing something with Fuel3D 
studio. 

The online publication like Sketchfab is one of the best known for 3D model. The CEO of Sketchfab, Alban Denoyel also 
expressed happiness. Denoyel feels interested people want a plat form which can help to grow viewing and sharing the 3D 
content. 

 

Image Courtesy: 3dprint.com 

The Fuel3D scanner will be in the market in the coming year. This great joint venture will expectantly guide to the fast extension of 
accessible 3D models, both for printing and claim, within the Sketchfab model depository. 

https://sketchfab.com/models/98FkJnqlrr9cDrhSYqXhRVjqoos/embed 

https://sketchfab.com/models/98FkJnqlrr9cDrhSYqXhRVjqoos/embed�
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Image Courtesy: 3dprint.com 

Ref: www.3dprint.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

http://3dprint.com/30049/sketchfab-fuel3d/�
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Perform the renderings of the SketchUp 8, SketchUp Make & SketchUp 2013 
models with Renditioner Pro V3 

Rajib Dey : Editor-in-chief 

IMSI Design releases Renditioner Pro V3, the most updated version of Renditioner that contains some advanced features and 
superior print quality. 

The users can use Renditioner Pro v3 to create eye-catching photorealistic renderings of the models through SketchUp 8, 
SketchUp Make, SketchUp 2013. 

Renditioner Pro v3 functions directly inside sketchup and load any model automatically. Just arrange the model for rendering 
through discerning drag and drop, lighting, material, camera and environment controls. 

There exist some professional rendering controls like Progressive and Sub-Image rendering which facilitate the users to promptly 
check and envisage diversified rendering scene variations of their design. Multi-threaded rendering will result in increasing the 
regeneration time to cope with your system. 

Renditioner Pro v3 contains the following exclusive features:- 

Superior quality Cameras and Lighting with HDR: High Dynamic Range (HDR) facilitates a high quality tonal and contrast 
detail revealing a completely new set of lighting possibilities with added realism. 

Expanded Libraries of Content: Renditioner Pro contains a well structured library having more than 150 materials, 72 finishes, 
50, 2D and 3D bump maps, and 27, 2D and 3D backgrounds. The users can easily use them into the models by just dragging and 
dropping them. There are also supplementary content accessible through the LightWorks’ Aspects Digital Asset Library. 

Simplified User Interface with Tutorials: Maneuver any SketchUp model through professional image controls which are 
smoothly arranged into brief menus for getting quickly. 

Multiple output formats: All the rendered images are saved as .JPG, .PNG, .TIF, .BMP, and .TGA file fomats 

Animation: The users can view a rotating animation of their model on its X-axis with turntable animation inside Renditioner Pro. 

Drag, Orbit, Look Around, Track In, and Walk Tools: The users can experience better control viewing and orienting the model 
with the above tools. 

New Glossy Optimization: Glossy optimization enhances the rendering speed of scenes having glossy materials. 

 

Material Blurring: It will create advanced material quality for producing more photorealistic renders and speeding up the 
rendering time. 

http://www.sketchup4architect.com/professional-rendering-for-sketchup-with-renditioner-pro-V3.htm�
http://www.sketchup4architect.com/download-google-sketchup-8.htm�
http://www.sketchup4architect.com/samples.htm�
http://www.sketchup4architect.com/sketchup-materials.htm�
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Progressive Rendering: By applying Progressive Rendering, the user will get a blocky, low quality view of the scene although 
the rendering calculations are carried out. 

Sub-image rendering: Characterize a segment of an image to render, rather than rendering the whole image. It will streamline 
the process of rendering of just the area of the image as per your choice. 

Downloadable link 

 

Image Courtesy : www.imsidesign.com 

  

http://www.imsidesign.com/Products/Renditioner/Renditioner-Pro�
http://www.imsidesign.com/�
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What are the best things to do with Sketchup 
Rajib Dey : Editor-in-chief 

Apply keyboard shortcuts. Keyboard shortcuts are very useful to save significant time while creating complex models with 
sketchup. Sketchup includes a wide array of shortcut keys which can enhance your drawing process. You can also customize and 
create your own shortcut keys by selecting Layers, Standard and Tool Set according to your choice. There are also predefined set 
of shortcuts inside sketchup. The quick reference card consists of various keyboard shortcut lists. Every version of sketchup 
contains its own reference card. One can export keyboard shortcuts for allocating amid other copies of sketchup. One can go 
through the window menu, select preference and then shortcut menu. In order to load it, just press the import button (available in 
shortcut window) and choose “preferences.dat. 

Watch tutorials. There are also several useful video tutorials on sketchup which help to learn how to use sketchup for 3d 
modeling, visualization, rendering, animation, wood working projects etc. These videos will help you to learn the basic and 
advanced features of sketchup. Besides, one can also learn the application of various tools inside sketchup. Google provides a 
series of sketchup video tutorial on their site. These short videos focuses on all ranging from the SketchUp tools, to advanced 
SketchUp uses, LayOut, Style Builder, as well as using SketchUp with Google Earth. You also visit some good third-party sites. 

Download pre-defined objects. While designing objects with sketchup, you can save significant time through Googles Bonus 
Packs or getting materials from the world's largest repository of free, high-quality, 3D content which can be utilized in your 
models. 

Edit pre-made objects. Any items of these pre-made objects can also be customized. You can use or remove components 
stairs, counters and bathtubs. Press edit/component/explode and you can maneuver all the individual parts. 

Apply layers. One can take help from layers in SketchUp to perform specific tasks smoothly as well as create your models neatly 
and make them workable. Gather your knowledge on how to apply layers and utilize them mostly in your designs. Here are some 
good tips. 

help.sketchup.com 
www.sites.google.com/site/sketchupsage/faster/layers 

Be trained at moving objects in sketchup. Sketchup can be a handy tool for moving objects. If you face any problem in 
manipulating objects, just get help from keyboard shortcuts. The arrow keys demonstrate the direction, and shift will be applied to 
lock in movement along a specific plane. 

Explore innovations

 

Image Courtesy: photos1.blogger.com 

Ref.: www.sketchupfans.com 

 

 

. Discover the new features of SketchUp and apply them for diversified applications. Test new things 
ranging from scaling the drawings from a photo or designing crafts or other fun projects. 

http://help.sketchup.com/en/article/116693�
http://help.sketchup.com/en/article/114924�
http://www.sketchup.com/learn/videos�
http://help.sketchup.com/en/article/117002�
http://help.sketchup.com/en/article/117002�
https://3dwarehouse.sketchup.com/?redirect=1�
http://help.sketchup.com/en/article/112791�
https://sites.google.com/site/sketchupsage/faster/layers�
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Some useful sketchup tips on sketchup sandbox tools 
Rajib Dey : Editor-in-chief 

SketchUp sandbox conception denotes a surface that is created and controlled through sandbox tools. A sandbox in SketchUp as 
well as other 3D modeling tools can be termed as a triangulated irregular network or TIN in terrain modeling jargon. 

TIN is similar to a sandbox as it contains a boundary along with a sculpted surface (sand). Sandbox tools are available inside 
SketchUp which can be applied for generating and maneuvering TINs. 

In TIN, there are various connected triangular faces which appear to be one continuous smooth surface if they are smoothed. 

Besides producing terrain with the sandbox tools, one will be able to generate other organic shapes (the shapes like crafted 
manually) with these tools. 

The sandbox tools are also compatible with polygon mesh which is another type of TIN-like surface. A polygon mesh is identical 
to a TIN, but having faces over three vertices. 

SketchUp's Sandbox from Scratch tool and Sandbox from Contours tool only generate TINs, but one can import a polygon mesh 
as well as make a polygon mesh (by hand) applying other SketchUp tools. 

Triangulation

 

Image Courtesy: geovisualization.wordpress.com 

How to generate a TIN: The following methods can help a user to get a starting TIN as the basis of their model:- 

: Triangles in a TIN are adjustable in diverse directions. The orientation of triangles is denoted as triangulation. In a 
TIN some triangles can be adjusted vertically and at the same time others can be adjusted horizontally. It is vital as some 
sandbox tools facilitate the users to modify the direction of the triangles in order to further smooth TINs. 

• Produce or import contour lines and apply the Sandbox From Contours tool for generating a TIN. 
• Import an image of a site plan or contour map and use the freehand tool to get its contours. Subsequently, fine-tune the 

contours to their exact elevation and apply the Sandbox From Contours tool to make a TIN. 
• Import a TIN applying the SketchUp ArcGIS Plug-in accessible on the SketchUp Plugins index. ArcGIS is Geographic 

Information System for performing with geographical information like the location of buildings inside a world-wide global 
coordinate system. 

• Import a digital terraIn Model (DTM) file. 
• Make sandbox (TIN) with the Sandbox From Scratch tool. 

How to alter a TIN: There are several tools inside sketchup which are useful for altering TINs. These tools range from Sandbox 
From Scratch, Sandbox From Contours, Smoove, Drape, Add Detail, Flip Edge etc. These sandbox tools are applied to produce 
organic geometry or geometry that looks like hand-crafted. 

Functional terrain: The phrase functional terrain can describe a terrain having no portion bending back upon itself generating 
overhangs, underhangs, or caves. While sketching a vertical line through the terrain at any point as well as the line only touches 
the terrain at one point, the terrain will be in operation. 
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It is vital as some specific tools like the Smoove tool, can produce unanticipated results at the time of performing with 
nonfunctional terrain (the neighboring points incorporated in the sculpting operation by the Smoove tool are frequently 
unwanted).. 

https://www.youtube.com/watch?v=AvtgwfBe84c 

 

Ref : www.help.sketchup.com 

  

https://www.youtube.com/watch?v=AvtgwfBe84c�
http://www.help.sketchup.com/�
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An exclusive course for sketchup users’ alias “Trimble SketchUp for Digital 
Fabrication and Prototyping” 

Rajib Dey : Editor-in-chief 

Participate with an exclusive course on Trimble sketchup alias Trimble SketchUp for Digital Fabrication and Prototyping. By 
undergoing this sketchup course, one can transform their 2d sketches into real time 3d presentation. One can learn how to 
produce 3D drawings to be utilized together with digital fabrication. Besides, one can learn how to apply sketchup for producing 
model in 3D that can be used with a 3D printer. 

The course will commence from Monday 24th November and continue for four week (four consecutive Mondays) focusing on the 
fundamentals of sketchup with the basic layout, menus and tools panels, to handy plugins and corporeal applications. This course 
will run over a four week period portraying the potential that lies within the friendly and forgiving interface of this 3d modeling 
software. 

Maximum 12 people can be accommodated with the course and classes will commence on four consecutive Mondays from 7pm – 
10pm. 

WEEK 1: In first week, the attendees will go through a short presentation on sketchup and its diversified usages. After that the 
attendees can walk around the prospective of each machine in the FabLab analyzing the relationship amid them and the Trimble 
Sketchup software. There will be small tasks for the week facilitating users to be well versed with the software and generate 3d 
models of their own. 

WEEK 2: In second week there will be discussion on how to resolve issues occurred in accomplishing the tasks in first week’s 
class. After that, the attendees will be introduced to a wide array of new features of sketchup as well as how to become 
successful in dealing with problems by apply the various tools inside sketchup. The attendees also learn how to convert the 3d 
objects into simple 2d versions by creating very simple forms on the laser cutter. Learn how to apply the software to prototype a 
jigsaw like assembly method with the help of a series of 2d planes which will transform into 3d objects. 

WEEK 3 & 4: In the 3rd & 4th week, the attendees have to make a 3d object of their own with the knowledge gathered in 1st and 
2nd week. The generated model will then be 3d printed in the final week. Explore the requisites essential for exporting the files 
and make them 3d printable. Each user will then gets scope for creating the design of a unique object and print it themselves. The 
cost of the complete course is 40 euros for students and 80 euros for adults. 

Register your seat now 

For more information, call +353 61 213 438 or send mail to fablab@saul.ie 

 

  

http://fablablimerick.ticketleap.com/sketchup/�
mailto:fablab@saul.ie�


  
 

36 | P a g e  
 

An exclusive tutorial on Mystique FX with 3ds Max 
Presented by Salah Hussein 3D Artist at Dragon FX Studio 

My inspiration come from X-men days of future past. This FX is Procedural so you can apply it to any mesh you want, 

 

open 3ds max 
create Thinking Particles System 
go to modifiers panel click on properties 
from TP system create Group and name it Active 
create two Dynamic set and name it 1- Birth 2- Run 
in birth dynamic set create matter waves from operators 

Open it 
pick object you want to scatter on it 
in Group : select Active Group 
make the other settings like the image (01) below 
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in birth Run set 
make ppass group and select the active group 

create ** 

Node from helper 
surface Follow From operators 
SCale From operators 
GeomInstance From operators 
particle Die From operators 
Particle Age From Conditions 
connected like the image below (02) 

 

in node 
pick the same object to keep the particles follow if your object is animated 

in Particle Age make it Absolute and set the age of you particles 

In GeomInstance pick your feather to make scatter in the object pr you can use my Feather you can dwonload the scene file from 
here you can find it in the description 

http://player.vimeo.com/video/112587229 

 

if you need any help you can email me 
My Email : salahinpeak@hotmail.com 

http://player.vimeo.com/video/112587229�
mailto:salahinpeak@hotmail.com�
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Importance of sketchup dynamic components in construction 
Warunyoo Songkran 

 

Pipes and fittings 

PART 01- Making Component Database 

The Dynamic components will represent anything in the construction world such as pumps, pipes, valves, steel, concrete or 
electrical instruments. The attributes that are assigned into the dynamic components can be simple pieces of extra information 
like Part Number, Cost and Weight. Attributes can also contain spatial relationships (like how two parts are positioned relative to 
each other), and behaviors (like animation and smart scaling). Some Dynamic Components are very simple (a pipe elbow with a 
part number attached), and some are very complex. 

An example of my dynamic component database 
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Concrete piles 

 
Steels 

An example of how I make these components 
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PART 02- Assembly the database to make a construction prototype 

By the collaboration between owners, construction management teams and contractors, I can assembly, move, rotate and scale 
all components in the model in the way that all people want to. The objective of this collaboration via the sketchUp model is to get 
the project prototype in which when it goes to the construction phase it will not change!. To do this is easy, firstly show the 
everyone the prototype and walk them through the model as if they are playing game. Everyone can change whatever they want 
to. 

Examples of my works 
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PART 03- Bill of Materials, Bill of Quantity and Construction Documents 

By using generate reports along with the dynamic component database I can make a Bill of Materials very quickly and more 
precise than ever before 
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LayOut is the program I have been using for making construction drawing. It links the plans, elevation and sections of the finished 
model to the 2d drawings within the 2D CAD environment. Updating and changing the construction drawings can be done more 
easy than conventional 2d CAD like AutoCAD, because the 2d construction document in LayOut can update automatically when 
the sketchUp model is changed or updated. 
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3D Printed Jewellery Collection for Men only 
Debamoy Ghosh 

You can find it in the market now. Earlier we have heard about 3D printed jewellery. But those were all for women. This time it is 
for men have some of those collections with the attires. 

The Cafe Costume and designer pair DAMN and Twikit 

A high-quality co-operation needed between DAMN and Café Costume for execution those jointly doing this assignment. Twikit 
here provides the technology of 3D customization. There is an easy to use option to place the choice of the designer’s material 
likings such as silver or brass. Hit to the

has created 3D printed Jewellery. They were encouraged by 
Kunstwerkstede De Coene’s work. 

‘De Coene’ is famous for making the 3D printed cufflinks. 

The artists - Caroline and Kim, from DAMN were enthralled to witness the work of De Coene. He has conventional nature work on 
wood. 

Here the Business World Fair was the ultimate place for getting the out-of-the-box concept for those designers. The expo was the 
platform for many budding designers. 

The design procedure and the result were come fourth during the Courtrai Interior Biennale 2014 at both Ventura and in the Café 
Costume shop on the Leiestraat. 

 cafecostume.twikit.com 

 

for your best options. 

Information and Reference:- i.materialise.com 

 

and the correspondent is Franky. 

 

http://www.cafecostume.com/�
http://www.damn.be/�
http://www.twikit.com/�
http://cafecostume.twikit.com/�
http://i.materialise.com/blog/entry/suit-up-for-the-damn-x-cafe-costume-3d-printed-jewelry-collection-for-men#more-17587�
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Fast style of SketchUp 2015 and its working talent 
Debamoy Ghosh 

In the hand-drawn visualization, it is not for all time, looked like it is completed. Here, the designers have to styling the SketchUp 
control show and the settings which changes the way the model appears. The SketchUp team member -- Josh Reilly has made a 
blog on this topic, from which we are made an excerpt. 

The style area is as follows: Applying, editing, Alignment of ages to axes, sharing, and watermark to be added to the drawing. 

There are some more style, those are: Control of Browser, Browser Face panel, Browser Background panel, Browser Watermark 
panel, Browser details menu, Browser Edge panel, Browser Modeling panel. 

The users can connect with the pre-defined style along with mixed attributing the elite exclusivity style. It is a practical and helpful 
access. Some of the style render faster, the others are sloth. 

The designers’ may desire to use Style settings in definite situations during modeling and appearance work. 

How to assign style scene: 

The designer can assign styles to individual scenes in your SketchUp file. 

• First of all, the designers have to select the Window > Styles menu item. Then the Styles Manager is displayed. 
• The next step is to select a styles compilation from the drop list, please consider the 'Assorted Styles.' 
• Then click on a style in the collection. The style is selected and applied to the current model. 
• Then select the Window > Scenes. The Scenes Manager will be displayed. 
• Click the Add Scene button (LOGO). A scene is added with the current style. 
• Do again steps 2 to 5 for extra styles and scenes. 
• Modifying a style assigned to a scene. 

The modification: 

• First of all select Window > Styles. The Styles Manger is displayed. 
• The select the In Model styles from the drop. The model styles are present there. 
• The click on one of the In Model styles for modification. 
• The select the Edit tab. The Edit panel is being exhibited. 
• Now you can regulate the style as essential. 
• Then click the update style in the changes button. 

What is the style render faster than other? 

If you are working on the big model, the style that you are using is to be noted. The age setting panel is looking like those ages 
that you can get from this link. 

The idea of fast style: It is a brand new feature of SketchUp 2015. It is available in both the version of SketchUp Pro and Make. 

The style setting that we are talking about is very fast. In the latest version of the SketchUp, a small watch is being showcased 
know the exact time taken. This is actually the main decisive factor of fast style. 

But the user here can get his or her, own fast style. Here the concept of style browser is very important. 

http://sketchupdate.blogspot.in/2011/10/speed-up-sketchup-use-fast-styles.html�
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Image Courtesy: sketchupdate.blogspot.in 

help.sketchup.com 

Here the users need to check out the

- please hit this link to get more information about styles. 

The users should stay away from the style choice; otherwise there is a possibility to of fall of work. The sketchy edges, profile and 
watermark can be crushed. 

 knowledge centre. 

And how it is save change: help.sketchup.com 

The fast style can be taken to the sketchup model. Here is the Link to be hit get the more information. 

This is the small flow chart to do it. 

Window > Style> 

And then simultaneously select>Edit>Mix. 

A Style somewhat like Fast Blueprint is a fine option while presenting the SketchUp model in a stylized fashion. But the smooth 
navigation and scene transition is somewhat the things that the user also wants. Users can also make a use of style without 
badge. 

But as the old proverb prevails, unity is strength; similarly it has a big advantage if style and scene work together. 

Here is the detail that how it works together. 

http://help.sketchup.com/en/article/114946�
http://help.sketchup.com/en/article/3000072�
http://help.sketchup.com/en/article/57625�
https://3dwarehouse.sketchup.com/model.html?id=u464631c1-d822-42eb-ae92-23a9677e9ce0�
http://help.sketchup.com/en/article/114931�
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Image Courtesy: sketchupdate.blogspot.in 

Ref: sketchupdate.blogspot.in 

  

http://sketchupdate.blogspot.in/2014/12/what-are-fast-styles.html�
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3D Model and Gadget that Matters 
Debamoy Ghosh 

Emirates 24/7 brings us some of the amazing gadgets some of which we cannot even visualize, a pen that recharge the cell 
phone or a wallet that alert you while lifting or it can even track the spot or a DVR recording TV programme. These are examples 
of 3D Modelling. 

Joseph George, the correspondent of the publication recently brings us some examples:- 

1. This pen not only writes well, but charges the phone. It also work as stylus. This product is called power pen. If your 
Smartphone possesses a 700mAh battery within, the pen can recharge it instantly. The tip of the stylus is prepared by 
rubber. It can be used by tab, phablet or any smart devices. But the power pen can white on the paper too like any usual 
ball pen. This device comes with black and gold in the market with approximately 15.5cm in length. The device will be a 
game changer in its market. It is at present selling at the price of 24.99 British pounds (Dh143). 

 

Image Courtesy: emirates247.com 

1. The Smartphone sterilizers are available in the market of UAE. It can remove 99 per cent of germ within some minute. It 
has double lamp disinfecting system and automatic cover. The Smartphone which that fit within the dimension of 125 x 225 x 
40 mm are handy to it. The price tag is bit moderate: $54 (Dh198). 
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Image Courtesy: emirates247.com 

1. KipstR – Records TV when you sleep It is very common to many of us who fallen asleep and TV programme had gone off. 
This device can record TV programme. This is basically a TV recorder. It is a 3D printed device. 

 

Image Courtesy: emirates247.com 

1. 3D Pen: - This pen can be used as charger too along with USB drive, stylus, spy cam as well as its core function of 3D 
modeling. It has the adjustable characteristic. It is called 3Doodler. This device is avaliable on Kickstarter and then launched 
other parts of the world and then UAE. 
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Image Courtesy: emirates247.com 

1. GPS enable wallet: - This wallet will come with GPS tracing ability and keep the police update the location if stolen. The 
device is priced at $99 (Dh363). 

 
Image Courtesy: emirates247.com 

Information and image Reference:- www.emirates247.com and Joseph George. 

 

 

http://www.emirates247.com/business/technology/gadgets-n-gizmos-smartphone-steriliser-gps-wallet-power-pen-2014-12-20-1.574048�
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Magazine Details – The Creative team of Sketchup-ur-Space 

Started in September 2010, Sketchup ur Space (SuS) was the first online magazine devoted to SketchUp, that 
unique, innovative 3D design tool from Google. It holistically covers features, events, news, updates, reviews 
and many tips and tricks. 

 

 

Rajib Dey: rajib@sketchup-ur-space.com 

Rajib, the editor-in-chief of SketchUp ur Space magazine is the main writer. He 
is responsible to write the cover story, blog and many other columns. Along 
with it, He is creating a liaison between the writers and the readers. 

 

 

Manoj Kumar Singh: manoj@jobs2india.com 

Manoj is enthusiastic helps to put the content of the SketchUp up Space 
magazine in the html version. Manoj is the html developer who beautifully 
creates each and every edition with care along with the PDF version. 

 

 

Abhishek Mondal: abhishek@jobs2india.com 

Abhishek is the designer-in-chief of this magazine with the help of his creativity 
Sketchup ur Space has gotten a classy as well as trendy look... 

 

 

Debamoy Ghosh: debamoy@jobs2india.com 

Pouring the confidence to budding 3D modelers is a challenge, which makes 
them believe that they can create a universe. I try to bring exciting stories that 
not only riveting read but put them the right technical path. After all, every 
right action needs believe and determination for fulfillment.   

 

 

mailto:rajib@sketchup-ur-space.com�
mailto:manoj@jobs2india.com�
mailto:abhishek@jobs2india.com�
mailto:debamoy@jobs2india.com�
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